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Abstract: On designing and realization of aesthetic appearance of compound woven structures, each of 
us uses any visual sources that could inspire us. In this paper were generated new woven structures on 
the principle of communicating vessels as a metaphor, so that one structure helps the other and is 
complementary to it. For this purpose was used ArahWeave CAD/CAM textile software for dobby and 
Jacquard fabric design and weaving, which offers such innovative design possibilities and helps to 
create amazing patterns. ArahWeave has a special function for constructing multiple layer weaves with 
different densities in warp and weft layers. The maximum weave size is „limited” to 65520 by 65520 
threads in ArahWeave Pro and 262080 by 262080 threads in ArahWeave Pro XL. In the Tools menu 
from Edit weave are advanced weave editing functions, which can be used both on dobby or Jacquard 
woven fabrics. As sample, in the Edit decomposed window from Tools, the weave area is split into 
„weave table”, where the number of columns is number of warps, and the number of rows is number of 
wefts. The „limitations” of a decomposed weave means maximum weave systems of 16 warps and 16 
wefts. These so-called „limitations” are motivated only by deeper due to technical weaving reasons on 
dobby and Jacquard looms. By applying weave to fabric tool, the result will be immediately visible on 
fabric in the main window, in a selected mode of view (Weave, Integer, Shaded integer or Simulation), 
and appears at the desired zoom level. The hyper realistic woven fabric simulations in ArahWeave, 
ArahDrape, ArahView3D or Arahne online configurator mean cost and time saving and the best design 
solutions for a creative work. 
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INTRODUCTION 

It is a difference between what is called artistic and decorative embellishment of woven 
fabrics. For example, the same landscape as painting and as image in Jacquard tapestry; for a painted 
landscape on canvas, the textile support is neutral and helps to create a realistic impression of 
perspective, while in Jacquard tapestry, the landscape glorifies the textile surface itself.  

Each of the specified techniques has its place in the world of beauty, but „one is the poetry, the 
other the prose of the art” [1]. 

The landscapes, portraits or organic motifs as copy after artworks or photographs can be 
achieved in brocades, Jacquard tapestries and damasks. These types of woven fabrics require more 
careful planning than other weaves, being a synthesis of the technical, aesthetics and structural aspects 
of textile design.  

The technical aspects refer to process of the loom. The weaves are obtained on a loom having 
a Jacquard attachment with individually control of raising and lowering for each warp thread. Named 
after the inventor, Joseph Marie Jacquard, the mechanical Jacquard loom dates back to the early 19th 
century and is considered the basis for modern programming and precursor of digital Jacquard 
technology. From perspective of aesthetic aspects, is necessary a complete understanding of the 
interaction between warp and weft threads, with focus on experimentation with different colors and 
structures of threads.  
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The structural aspects of Jacquard tapestry involve multiple layer weaves one on top of the 
other. The alternate positions of colored warp and weft threads in the weave repeat allow the optical 
mixing of colors and thus, the image control on structure design. This intricate weave is visually 
powerful, because the colors „are woven” into unique way that cannot be obtained in 
traditional painting techniques or digital photography, like colors of pigments or colors of light. The 
visual impact is created by using together the chromatic and achromatic colors of warp and weft 
threads.  

A professional textile designer can manage all these aspects from the concept development to 
engineering design and manufacture of fabric, almost effortlessly, by digital practice and modern 
technological resources.  

In this work, has been exploring special functions for constructing single- and multi-layer 
weaves of ArahWeave software, included in ARAHNE package. ARAHNE is a global leader in 
CAD/CAM software optimized for dobby and Jacquard fabric design and weaving. ARAHNE is a 
software company established in 1992 in Slovenia, which provide sustainable solutions for the highly 
competitive textile business, thanks to „a programmer who understood weaving and a weaver who 
twisted the weaves until his head was spinning”. In ARAHNE package are also included ArahPaint for 
drawing and image editing, ArahDrape for texture mapping and ArahView3D to show fabric on the 
3D model [2]. 

I. COLOR EFFECTS IN WEAVES 

A compound weave or multi-layer weave is made of at least three threads systems. There are 
also double, triple and quadruple weaves, and multiple layer weaves can be constructed. These weaves 
have a great structural diversity and allow achieving an advanced degree of concordance between their 
structural, functional and aesthetic properties requested by users [3]. 

In multi-layer weaves the color is a variable phenomenon. The color cannot be easily 
visualized and created with little knowledge of weaving design and techniques. The phenomenon 
associates with color are even harder to be explained.  

When is used in weave, the color is „affected” and „altered” in different ways by all structural 
parameters, such as raw material, yarn finesses, hairiness of yarn, sense Z- or S-twist yarn, number of 
twists in yarn, fabric density, fabric thickness, transparency, fabric mass per unit area, and surface 
design. The distance between observer and textile surface, the viewing angle, natural and artificial 
light sources, quality and direction of lighting on surface, and finishing technique, also affect the 
appearance of colors. The ability to choose and combine colors involves an understanding of each 
structural parameter which influences each color or combination of colors. Therefore the colors should 
be treated in compound weaves as an artist treats the mixing of paints on a palette. 

The analogous color schemes combine colors that are adjacent to one another in the color 
wheel. These colors give harmonious effects in weaves, but show only subtle color variations from 
different viewing angles.  

The contrasting color schemes are based on opposing hues and include both warm and cool 
hues. The high contrast of complementary colors creates the maximum visual impact. The 
complementary colors are opposite each other on the color wheel, as red and green, yellow-violet, and 
blue-orange. For example, mixing equal proportions of red and green threads creates on weave the 
same illusion of grey brown hue, such as in paints.  

The juxtaposition of colors in weave generates a phenomenon known as simultaneous 
contrast, studied and described by Johannes Itten. The theory of simultaneous contrast of Itten refers to 
the chameleon quality of a color and affirm that colors, when are viewed together, share some of their 
complementary color into other colors. In textile surface design simultaneous contrast can be used to 
obtain the desired color effects. The unwanted effects of simultaneous contrast are important when it is 
required to combine more colors as in constructing compound weaves. In paints, this problem can be 
diminished by altering the color quality of one of the colors used. 

To conclude, in a weave, similar colors will neutralize each other, and opposite colors will 
intensify [4]. 
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The ArahWeave software „mixes” the colors and creates the desired color effects. Working 
with primary colors, and non-colors, white and black, when the threads are „mixed”, all sorts of colors 
are created. All view modes of fabric simulation and great tools of Arahweave were developed for a 
clear understanding how the colors of the threads can create visual texture and pattern in single- and 
multi-colored weaves.   

II. AN OVERVIEW OF BASIC DESIGN TOOLS IN ARAHWEAVE 

ArahWeave is a very powerful software for dobby and Jacquard fabric design and weaving, 
but with a few „limitations” justified only by deeper due to technical weaving reasons.  

A few examples are chosen to exemplify some of these „limitations”: 
 maximum weave repeat size: ArahWeave Pro 65520 by 65520 threads; ArahWeave Pro XL 

262080 by 262080 threads; 
 maximum size of image for Jacquard conversion: 65520 by 65520; 
 maximum number of hooks in Jacquard loom layout: 65520; 
 maximum weave systems: 16 warps and 16 wefts; this means that weave area can be split into 

„weave table” with maximum 256 weaves (16×16); the number of columns correspond to 
number of warps, and the number of rows to number of wefts; 

 number of different yarns in warp or in weft: 25; 
 two decimal points Fabric density: minimum 1 thread/cm and maximum 50000 threads/cm; 
 zoom level of woven fabric: minimum 5% (twenty times smaller) and maximum 1600% 

(sixteen times bigger) [5]. 
These „limitations” raise the question: in which direction the digital Jacquard technology will 

heading to achieve more textile expression than at present?  
ArahWeave software has special functions for constructing single- and multi-layer weaves. 

They are included in Edit weave and Jacquard conversion windows from Weave menu. For setting the 
number of weave systems and size repeat in warp and weft is used Change weave window (Weave > 
Edit weave > Edit > Dimension > Change weave).  

Edit decomposed is other special function for constructing compound weaves, available in the 
weave editor (Weave > Edit weave > Tools > Edit decomposed). After specifying of basic weave 
repeats for each layer and their size in terms of number of warp and weft threads, the ArahWeave 
automatically constructs the compound weave. 

Figure 1 shows the Edit weave window for a colored multi-layer weave with five warps, three 
wefts and cross section view in edit weave window. In Edit decomposed weave editor, the compound 
weave repeat size is split into „weave table” with fifteen different weaves and color combinations 
possible. For example, the selected weave repeat (red) is a combination of fifth warp and first weft.  

 

 
Figure no. 1. Edit decomposed weave editor 
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When a weft thread is inserted into shed, lies on top of some warp threads and underneath 
others, producing an interlacement sequence of unders and overs. Conventionally, the weave 
representation appears as a combination of black and white squares. Warp over weft intersection is 
represented by a black square and weft over warp intersection by a white square.  

The appearance of colors in Jacquard compound weave is given by composition of layers for 
each color from weave. The result of successive interlacement sequences for each weft thread 
generates different colors in compound weave. The Decomposed colors view is a great tool for 
composing multi-layer weaves, especially for placing the stitching points between the fabric layers, 
together with cross section view. In figure 2 is a detailed representation of decomposed color in a 
compound weave with five warps and three wefts (figure 2). 

 

 
Figure no. 2 Decomposed color view - detail 

 
The ability to compose and decompose weaves operates on the principle of communicating 

vessels as a metaphor. There color and weave effects with small repeat sizes help the compound 
weave, and are complementary to it. The ArahWeave's multitasking windowing platform also works 
on the same principle, since many tools can be used concurrently on the screen. The effect of changing 
any structural parameters of fabric can be observed in main window in one of the desired view modes 
(Weave, Integer, Shaded integer or Simulation) and appears at the desired zoom level. 

The Jacquard conversion window has its own menu bar, options and tools. The Normal 
conversion is the default setting of the Jacquard conversion window, where can be loaded a weave for 
every color from pattern. Besides common conversion (Normal) are five additional type of conversion 
(Shading, Random shading, Extra wefts, Fil coupé, and Weave blanket).  

ArahWeave software offers two great tools, the Shading and Random shading conversions, 
which makes enable the creation of shading effects on fabrics in different ways.  

The source of inspiration is no longer a problem since can be aesthetic and structural 
harnessed in grayscale and color shading, random shading, combination between grayscale and normal 
Jacquard conversion, and color shading with tapestry weaves. As a result, you can draw inspiration 
from anything around you or may find inspiration in something you cannot even see. 

III. HOW TO SHADE WITH ARAHWEAVE 

The types of shadings were thus selected to obtain the best simulation results of the 
photographic composition as grayscale shading and color shading with tapestry weaves, both selected 
from Weave > Jacquard conversion > Shading. 

3.1. Grayscale shading 

Grayscale shading is the more popular conversion, since can transform any seamless repeat 
patterns, or full width images for weaving portraits or landscapes based on photographic images. This 
conversion can be used even by non-professionals in the field of digital Jacquard technology.  
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ArahWeave software can convert a color image to the grayscale mode and then can achieve 
the best contrast with the Contrast stretch function.  

The Jacquard weave shading is constructed on the basis of one weave. Can be loaded any 
basic satin or twill weaves with warp- or weft faced, depending of grayscale histogram of image and 
selected colors in warp and weft. The direction of the shading can be chosen horizontal or vertical, by 
adding points in the basic weave, or random shading conversion can be selected. The chiaroscuro 
effect in fabric simulation will be even more successful if is used a chromatic differences between the 
warp and weft threads. Itten's color contrasts or the contrast between colors and non-colors can work 
compositionally better. The result obtained for Random shading conversion on weft-face satin weave 
is depicted in figure 3. 

 

   
Figure no. 3 Jacquard weave simulation in Random shading 

 
In zoomed image can be observed that are not long float errors and no correction are 

necessary. Even novice users, less familiar with designing procedure followed for Jacquard weave, 
consider this as a great advantage in their creative works. The detailed grayscale shading can be 
viewed directly in Weave mode (View > Weave) at desired zoom level settings (figure 4). 

 

 
Figure no. 4. Detail of grayscale shading at 400% zoom level 

 

3.2. Color shading 

In Arahweave’s color shading, the number of colors from image is equal to the number of 
weaves. Color shading can express any color image into a Jacquard fabric with roughly the same 
colors and without any color reduction. The chromatic attributes depend on not only the threads colors 
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in fabric and colors ordering in patterns, but also the arrangement of threads floats in the fabric face-
layer. During gradual transition from one color shading to another, ArahWeave examines the loaded 
image in Jacquard conversion window, calculates all possible weave combinations, and replace color 
pixels with most appropriate weaves, based on color similarity.  

The figure 5 presents comparative two Jacquard fabric simulations of the same image. The 
simulation on the left was designed as single-layer weave in grayscale shading and on the right as 
multi-layer weave in color shading.  

 

      
Figure no. 5. Grayscale shading (left) and color shading (right) 

 
The weave size in warp depends on the numbers of hooks of Jacquard loom [6]. This number 

is typed in the warp field. The weave size in weft is calculated from the fabric density, which has to be 
set in the Set weaving density window (Fabric > Density and control). In this example, both Jacquard 
fabrics use only 800 hooks, but more hooks will be able to render the image with much more details  

The electronic Jacquard heads use multiples of 512 hooks which provide widths of 1536 (3×), 
3072 (6×) etc. The largest head is Stäubli electronic Jacquard machine LXXL with 23040 hooks wide 
(45×512). Formats up to 51200 hooks can be achieved by combining 2 machines, with spectacular 
results in Jacquard woven fabrics. 

The simulation of Jacquard tapestry in color shading conversion has five different threads in 
warp and three different threads in weft. Thus fifteen different weaves and color combinations are 
possible (warp1-weft1, warp1-weft2, warp1-weft3 … warp5-weft2, warp5-weft4).  

The composition of the weavings is highly sensitive in terms of such image conversion. The 
dithering or non-dithering technique and the noise option should be used in this transformation. There 
is no rule to use the noise and dithering options, the choice depends on the gradual transition of colors 
between shades and on the final color effects desired. 

Other digital tapestries constructions were developed in color shading conversion, inspired by 
two photographic compositions, author Violeta Radu, a Romanian visual artist. The pattern seen as 
projection on palms together and handshake represents the double spiral, for the first time appeared on 
the painted ceramics of the Cucuteni culture.  

The double spiral is a sign capable of fully representing its symbolic significance in many 
variants and combinations. It constitutes a symbol of inversion and of the intercommunication between 
two opposite principles.  
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This ancient civilization is an invaluable source of inspiration for modern material culture. 
It was chosen the same compound structure, five warps and three wefts, but for more accurate 

color rendering were changed the warp and weft colors. Color of threads was changed in Edit colors 
window (Fabric > Colors). Figure 6 illustrates how is working Jacquard conversion window, together 
with decomposed weave and color editor. In background the effects of these changes can be seen 
immediately on fabric simulation in bottom left. 

 

   
Figure no. 6. Color random shading in Jacquard weaves editor 

 

Usually appear considerable number of long floats after color shading conversion. Therefore it 
is necessary that before preparing the file for weaving to correct all float errors (Edit weave > Change 
> Float). In figures 7 and 8 are presented simulations of Jacquard tapestry fabrics at 33,3% zoom level.  

 

 
Figure no. 7 „Cucutenian dipper” – Jacquard tapestry fabric simulated at 33,3% zoom level 
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Figure no. 8 „Cucutenian node” – Jacquard tapestry simulated at 33,3% zoom level  

IV. CONCLUSION 

When copy-and-paste is the current modus operandi in textile design, the photographic image 
is an alternative way to connect with any inspiration source for a further development on Jacquard 
tapestry fabric. 

In this paper, the Cucutenian source found its way back to me through an emotive relationship 
with the double spiral as pattern, a sign that simultaneously connects and separates, and through 
exploring the spectrum of digital technology, embedded within artistic context. 

The powerful tools of simulation of ArahWeave software helped me to transpose photographic 
image into the language of Jacquard tapestry in the most appropriate manner. 

 A professional textile designer can achieve more expressions for textile surfaces (almost) 
effortless with the help of digital Jacquard technology. 
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